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SUMMARY OF FEBRUARY 2005 REVISIONS–VERSION 2.1.0.0 
 

Since the release of EngAsst Version 2.0, several error reports and user requested enhancements have been 

received. This release of EngAsst Version 2.1.0.0 contains the following error corrections and enhancements: 

 

EngAsst Version 2.1.0.0 contains the following revisions: 

 

1. For engineering programs that have been converted to DLL, EngAsst can now run the DLL directly, giving a 

more consistent windows look and feel to the engineering program. (Request 035) 

 

2. The "View" menu is now disabled when EngAsst is first started. (Request 104) 

 

3. EngAsst now confirms if an engineering program is to be unregistered. (Request 115) 

 

4. The Input Edit Window / Documentation Display Area background is now white for images. (Requests 123 

and 134) 

 

5. When an engineering program executable cannot be found, the error message is now more specific about 

identifying the executable. (Request 136) 

 

6. If the user clicks "Cancel" on the "Open Input File", "Select Engineering Program" or "Register/Unregister 

Engineering Program" dialogs, the original input file remains open. (Requests 147 and 148) 

 

7. Text included on a TTL command is no longer converted to upper case. (Request 194) 

 

8. The text on the OK button on the "Select Engineering Program" window is now all upper case. (Request 214) 

 

9. Output files containing null characters will now print properly. EngAsst will now replace the null characters 

with spaces before printing. (Request 215) 

 

10. Revision request submission information has been added to chapter 9 of the User's Guide. (Request 216) 

 

11. Input files for EngAsst can now be specified and loaded from the command line. (Request 218) 

 

12. A warning will now be displayed informing the user that EngAsst cannot run engineering programs that are 

specified on a UNC path (i.e. \\server\share). All engineering programs must reside on a local or mapped 

drive (i.e. <drive>:\folder). Previously, EngAsst would display a cryptic error message. (Request 224) 
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13. Acrobat Reader no longer needs to be installed in order for EngAsst to run. If Acrobat Reader is not installed, 

however, the user will be warned that engineering program User's Manuals will not be available for viewing 

through EngAsst. (Request 225) 

 

14. EngAsst no longer interprets the character "1" in the first column of an output file as a page break. This 

revision was made to eliminate formatting problems for certain output files printed by EngAsst. (Request 226) 

 

15. The PDF ActiveX control has been removed from EngAsst because it is not used and references to it 

sometimes caused problems. The user can still view the program User's Manuals via Adobe Acrobat Reader. 

This revision makes EngAsst fully compatible with Adobe Acrobat version 7.0. (Request 228) 

 

16. The "Version" column width that appears when the "Register Engineering Program", "Change Program 

Association" and "Select Engineering Program" commands are chosen has been increased to accommodate 

test versions of the engineering programs. (Request 229) 

 

17. A check has been added to the EngAsst installation program to ensure EngAsst will only be installed to local 

hard drives, not network drives. This revision was made because EngAsst is not capable of running from a 

network drive. (Request 230) 

 

18. If an input file containing invalid commands is opened, the invalid commands are removed and the file must 

now be saved before running the engineering program. (Request 233) 

 

19. The size and location of the program status window is now remembered. (Request 237) 

 

20. Only one program/version combination at a time can now be selected on the Unregister/Select Engineering 

Program window. Also, there are now no default rows selected (Request 239) 

 

21. Many corrections and clarifications have been made to the User's Guide, as well as having the User's Guide 

open from the "Help" menu of Engineering Assistant when program assistance is required. (Request 240) 

 

22. When the "System Info" button on the "About Engineering Assistant" form is clicked, two more possible 

locations for MSINFO32.EXE are checked in case the location cannot be read from the registry. (Request 

242) 

 

23. There is now a link to a generic revision request form in Microsoft Word template format from the "Help" 

menu. (Request 244) 

 

24. The main window of the program will now load before the command line arguments are processed so that the 

program will show up on the taskbar after double-clicking on an associated input file. (Request 245) 
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The following is a list of reported problems, user requests and clarifications that will be addressed in a later  

version of EngAsst: 

 

1. Add the capability to EngAsst to print a copy of the engineering program input file. (Request 033) 

 

2. Automatically update the index view when records are added, deleted or modified. (Request 073) 

 

3. Add a horizontal scroll bar in the program output table of contents window. (Request 086) 

 

4. Change the window divider from a slider control to standard split screen. (Request 087) 

 

5. Add 'move to beginning' and 'move to end' tab controls. (Request 088) 

 

6. Standardize the capitalization in program output table of contents (Request 089) 

 

7. Designate the required input fields for engineering programs. (Request 092) 

 

8. Define maximum and minimum field values for both SI and US units. (Request 095) 

 

9. Label the input field with the implied units. (Requests 094, 222) 

 

10. Reapply the tab rules after inserting a record. (Request 096) 

 

11. Provide context sensitive help when the <F1> function key is pressed. (Request 097) 

 

12. Make the 'Field Documentation' window dockable. (Request 119) 

 

13. Do not prompt the user for changed data after saving data when cursor is in masked edit field. (Request 128) 

 

14. Add the ability to turn off masking on all fields simultaneously. (Request 118) 

 

15. Force the main window to be active when closing the output window. (Request 213) 

 

16. Allow use of the keyboard to clear a selection in the drop down boxes. (Request 165) 

 

17. Alert the user of potential loss of data precision when importing files. (Request 195) 

 

18. When importing files with multiple lines of comments, associate the last line of comments with the command, 

not the first line. (Request 196) 
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SUMMARY OF OCTOBER 2005 REVISIONS–VERSION 2.1.0.1 
 

Since the release of EngAsst Version 2.1.0.0, several error reports and user requested enhancements have been 

received. This release of EngAsst Version 2.1.0.1 contains the following revisions: 

 

1. The installation of EngAsst has been modified to include RunProgDLL.DLL, a library that is needed on some 

machines to allow newer versions of the engineering programs to run. (Request 248) 

 

2. The configuration files for BOX5 and LLBOX have been updated to provide correctly formatted input. 

(Request 253) 
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SUMMARY OF FEBRUARY 2007 REVISIONS–VERSION 2.3.0.0 
 

Since the release of EngAsst Version 2.1.0.1, several error reports and user requested enhancements have been 

received. This release of EngAsst Version 2.3.0.0 contains the following revisions: 

 

1. EngAsst will now work with Engineering Dataset Manager as the editor for the datasets. (EngMgr Request 

001) 

 

2. A user can now type a negative sign (-) or a decimal (.) into a highlighted field and have it accepted. (Request 

247) 

 

NOTE: Due to the nature of the revisions, EngAsst version 2.3.0.0 was not released to external users. 
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SUMMARY OF APRIL 2011 REVISIONS - VERSION 2.4.0.0 
 

Since the release of EngAsst Version 2.3.0.0 several revision requests and user requested enhancements have 

been received. This release of EngAsst Version 2.4.0.0 contains the following revisions and enhancements: 

Programming Revisions 

1. The program has been revised to use Microsoft's .NET platform, using Visual Studio 2005 (Requests 258, 283, 

284, 285, 286, 287, 288). 

2. Information entered on tabs that are subsequently rendered disabled because of other program input will no 

longer be saved in the input files generated by EngAsst. Previously, the information on disabled tabs was saved 

to the input file, which could cause the engineering program to stop with an error (Request 270). 

3. A printing problem that occurred when a file without manual page breaks was exactly six pages long was 

resolved with the conversion to the new method of printing in the .NET version of EngAsst (Request 273). 

4. EngAsst will now look for a REPORT.INI file in the engineering program config directory before looking in the 

EngAsst installation directory. This will allow for the creation of program-specific REPORT.INI files for programs 

that still use the traditional program output form (Request 282). 

5. If any of the text output files are held open by some other program or process, EngAsst will show a dialog 

stating this and will not run the engineering program. Previously, EngAsst would stop with an error (Request 

295). 

User Interface Revisions 

6. The Field Documentation information is now presented in a pane on the right-hand side of the window, rather 

than appearing in a separate window that must be opened by the user (Request 119). 

7. A situation where extra decimal points were being added to an editmask field by tabbing in and out has been 

resolved (Request 264). 

8. The directory that is shown when opening a file will not be modified when a new engineering program is 

registered, but it will be changed when EngAsst is opened from a command line or through a context menu 

(Request 266). 

9. EngAsst has been enhanced to open PDF output from the engineering programs, when available. Users can 

also disable this option via an entry on the Edit menu (Request 280). 
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User's Guide Revisions 

10. The Bureau, Division and Section name of the PennDOT organization responsible for EngAsst has been 

updated (Request 274). 
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SUMMARY OF NOVEMBER 2011 REVISIONS - VERSION 2.4.0.6 
 

Since the release of EngAsst Version 2.4.0.0 several revision requests and user requested enhancements have 

been received. This release of EngAsst Version 2.4.0.6 contains the following revisions and enhancements: 

Programming Revisions 

1. EngAsst now invokes the engineering program DLLs directly, not through RunProgDll, to avoid intermittent 

program hangs. As part of this revision, menu options have been added to the Edit menu to change how 

EngAsst runs the engineering programs. These options should only be selected when requested by Department 

support personnel (Request 305). 

2. Choosing a range of pages to print from the program output form should now work as expected. The range of 

pages to print should now be set correctly, as well (Request 307). 

3. Running a program with a special live load file (e.g. BAR7) then running a program that does not allow 

specification of a special live load file (e.g. STLRFD) will no longer result in a special live load file being specified 

for the second program's run (Request 308). 

4. The syntax of the command used to open the engineering program PDF output was modified to resolve an 

intermittent problem with opening the output (Request 309). 

5. Attempting to search for a string in the output file when the file is already positioned at the end of the output will 

no longer cause an exception to be thrown (Request 311). 

User Interface Revisions 

6. Many modifications have been made to how EngAsst handles data input for masked edit boxes (e.g. input to 

BAR7, PS3, CBA or BSP) (Request 306). 

7. EngAsst has been modified so that the second record (and subsequent records) inserted for a recordset will no 

longer be prefilled with spurious data from the first record. In addition, the edit masks will no longer be removed 

from the first record when moving back to that record (Request 310). 

User's Guide Revisions 

8. Email addresses have been changed to "pa.gov" from "state.pa.us" (Request 304). 
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SUMMARY OF AUGUST 2013 REVISIONS - VERSION 2.4.0.9 
 

Since the release of EngAsst Version 2.4.0.6 several revision requests and user requested enhancements have 

been received. This release of EngAsst Version 2.4.0.9 contains the following revisions and enhancements: 

Programming Revisions 

1. EngAsst now calls an initialization DLL on startup to avoid a program hang that was occurring on some PCs 

with the 64 bit version of Windows 7 or Windows 8 (Request 313). 
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SUMMARY OF JULY 2014 REVISIONS - VERSION 2.5.0.0 
 

Since the release of EngAsst Version 2.4.0.9 several revision requests and user requested enhancements have 

been received. This release of EngAsst Version 2.5.0.0 contains the following revisions and enhancements: 

Programming Revisions 

1. The program has been revised to use Microsoft's .NET platform, version 4.5, using Visual Studio 2012 

(Requests 301, 313, 319). 

PLEASE NOTE: Due to program changes from this upgrade, changes have been made to how the engineering 

program interface with EngAsst. All engineering programs released after this version of EngAsst will incorporate 

these interface changes. Older engineering programs will continue to work with EngAsst, but when they are 

run, the screen output from the program will appear in a console window (similar to choosing "Run EXE - 

Command Window" from the "Edit" menu). Only the appearance when running the engineering program will 

change. Input and program output are unaffected. 

2. The program will now correctly read in input files with continuation lines combined with tab characters on the 

continued line. Previously, the presence of the tab character would cause the program to lose some input data 

(Request 262). 

3. If an engineering program input file, created outside of EngAsst, has more than the allowed number of a given 

command, the commands up to the allowed number will be retained, and any commands after that will be lost 

(a warning will be issued, and the user can close the input file before saving it to keep all data and have an 

opportunity to edit the file so that no data is lost). Previously, the first n - 1 commands and the last command 

would be kept, with all entries between n-1 and the last command lost (Request 267). 

User Interface Revisions 

4. If the program output window is minimized, it will be restored the next time an engineering program is run. A 

separate icon will also appear at the bottom of screen to allow the user to choose the output window at any 

time (Request 312) 
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SUMMARY OF OCTOBER 2018 REVISIONS - VERSION 2.6.0.0 
 

Since the release of EngAsst Version 2.5.0.0 several revision requests and user requested enhancements 
have been received. This release of EngAsst Version 2.6.0.0 contains the following revisions and 
enhancements: 

Programming Revisions 

1. If the user double-clicks on a line in the Index View, the program was selecting the incorrect input tab. 
The program will now change to the proper input tab (Request 324). 

2. The program was not recognizing the REPORT.INI file included with the Sign program because of a 
formatting issue in the program output file. EngAsst has been modified to look for a different character 
string in engineering program output to trigger use of the REPORT.INI file (Request 325). 

3. An engineering program can now be accessed on a UNC path as well as on a mapped drive path. 
Previously engineering programs could only be accessed if they were located on a mapped drive 
(Request 334). 

4. When 100 or more records are read into EngAsst and displayed on a tab, the total number of records 
shown on the tab will now be visible. Previously, the control that displayed the total number of records 
on the tab was too small to display numbers exceeding 99 (Request 336). 

5. A program crash during viewing program output in the EngAsst output viewer has been resolved by 
changing the casting of a value from a single precision value to an integer (Request 337). 

6. EngAsst no longer depends of the presence of a specific key in the computer registry to check for 
Adobe Acrobat Reader. The program should now open the PDF of the engineering program even if 
Adobe Acrobat is not the default PDF reader on the computer (Request 338). 

7. EngAsst was updated to be compiled with Visual Studio 2017, Version 15.4.3, and the .NET Framework 
4.6.1 (Request 344). 

8. EngAsst no longer crashes when a graph with results that are all zero is requested. The program will 
now set the upper limit to +1.0 and the lower limit to -1.0 for situations like this, and the results will be 
plotted as a horizontal line at 0.0 (Request 347). 

9. If the user scrolls to the bottom of a long description in EXTENDED FIELD HELP, then clicks into a new 
field, the form will now automatically scroll back to the top. Previously, this form would not scroll back 
to the top, making it appear that no extended field help was available (Request 350). 
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Output Revisions 

10. For engineering programs that produce the appropriate output (file names that end with _DBR.CSV and 
.DBT), EngAsst now provides the ability to show a graph of the unfactored analysis results for 
moments, shears, and deflections for all dead and live loads. At this time graphs can only be created 
for the PSLRFD v2.12.0.0 and STLRFD v2.5.0.0 programs currently under development, but this 
capability will be added to other programs in the future. (Request 318).  

11. In the Program Output form, all of the table of contents entries will now appear for programs that have 
multiple Table of Contents sections or have pagination within the Table of Contents (Request 322). 

12. The graphing output has been enhanced to show the limits of each span, allow simple and continuous 
results for PSLRFD composite dead load output, and to allow the user to choose which spans to show 
(Request 351). 

Input Revisions 

13. Numeric input textboxes will now be checked for valid characters (0-9, negative, decimals) when an 
input file is read in to warn the user of invalid input (Request 327). 

14. EngAsst will now read in record sets properly even if they contain some undefined records. Previously, 
this would result in not all record sets being read properly (specifically, Special Live Load record sets 
that did not have any SAL records defined would be removed from the input file) (Request 330). 

15. Input files created with the old PennDOT Input Data Processor (IDP) program (prior to the existence of 
EngAsst) will now have the correct commands associated with them without the user having to choose 
the commands (Request 332). 

16. Comboboxes (where the user can type in a value or pick from a list) will now accept values that are not 
on the list, while dropdown boxes (where the user must pick a value from a list) will now generate an 
error if a value is in an input file that is not on the list (Request 335). 

17. When opening an input file inside EngAsst, the file extension INP has been added to the default list of 
input file extensions (Request 340). 
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1 SUMMARY 
 
 
 
 

The Engineering Assistant (EngAsst) is a Windows application developed by the Pennsylvania Department of 

Transportation (PennDOT) to provide a graphical user interface (GUI) for PennDOT’s engineering programs. The 

data for the input to the engineering program is presented in a user-friendly format, reflecting the implied structure 

of the data, showing each record type on a separate tab page in the display and showing each field on each record 

with a defining label. 

 

With EngAsst the user can create a new input file, modify an existing input file, import input files, run the associated 

engineering program and view the output in a Windows environment. The help and documentation are provided, 

including text descriptions of each field, relevant images, and extended help text at both the record/tab level and 

the field level. Access to all parts of the Engineering Program User’s Manual, where available, is also provided 

within EngAsst. 

 

In general terms, there are two classes of input files supported by EngAsst: 

 

1. Fixed Format input files used by the older engineering programs (e.g. BOX5, PS3, and BAR7) that 

require input forms and data fields to be coded in specific columns on each record type. 

 

2. Command Style Free Format input files are used by the newer series of engineering programs 

conforming to LRFD Bridge Design Specifications and Metric units (e.g. STLRFD, PSLRFD, BRGEO) 

that allow the records to be "free-form", beginning with a Command keyword and comma-delimited 

Parameter definitions. 

 

There are two significant differences in how these formats are handled within EngAsst: 

 

1. Numeric Field Processing 

Numeric fields in the fixed format style are required to be a defined number of digits, with any decimal 

point being "implied" (Note: The decimal point will appear in the field to show its implied location.). For 

example, a value of 1.2 in a four digit field with an implied significance of two decimal positions would 

be entered as "0120". When entering this value in EngAsst, the keyed data will be right-justified and 

zero-filled when you tab away from that field. By default, no decimal point or negative sign can be 

keyed. To override this default format, and change the location of the decimal point by explicitly entering 
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it, or to enter a negative sign or an "alpha" character (sometimes required for negative numbers in this 

format), you must first remove this input restriction (i.e. turn the "edit mask" off by pressing the F12 key 

while editing that field). Note that the field label will turn red to indicate that you must use caution when 

entering data in an "unmasked" numeric field. 

For Command style input, numeric values are free format, and the decimal point must be keyed by the 

user. Decimal precision is the responsibility of the user. 

 

2. Importing Existing Input Files not created with EngAsst 

Existing command style input files have a record type code preceding each data record, and when 

importing these input files into EngAsst, these type codes will be recognized and the data displayed on 

the correct tabs in the Input Edit window. The fixed format input files do not have any indicator of record 

type. When importing one of these input files, the user will be presented with an Import Input File 

window and the user must manually assign a record type to each record. Note: some existing input 

files that were created using a PennDOT Input Data Processor (IDP) program will automatically be 

recognized by the Engineering Assistant and the data will be displayed on the correct tabs in the Input 

Edit window. 
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2 GETTING STARTED 
 
 
 
This program is delivered via download from the Department's website. Once payment has been received by 

PennDOT you will receive a confirmation e-mail with instructions on how to download the software. The download 

file is a self-extracting installation file for the licensed PennDOT engineering software. The engineering program 

runs as a 32-bit application and is supported on Windows 7, Windows 8.1 and Windows 10 operating systems (32 
and 64 bit versions). 
 

Your license number, license key and registered company name, found in the e-mail received from the Department, 

are required to be entered when installing the program and must be entered exactly as shown in the e-mail. The 

license number, license key and registered company name will also be needed when requesting future versions of 

the program (i.e., enhancements, modifications, or error corrections), and requesting program support. A backup 

copy of the program download and e-mail instructions should be made and used for future installations. You may 

want to print the software license agreement, record the license number, license key and registered company name 

and keep it in a safe place. 

 

To install the program, follow the installation instructions provided with the original e-mail from the Department. 

 

Before installing EngAsst, the user must have Internet Explorer (at least version 5.5) installed on the machine with 

EngAsst. If the user wishes to view program User's Manuals through EngAsst, Adobe Acrobat Reader (at least 

version 4.0) must also be installed. 

 

The following files will be installed in the destination folder, which defaults to "C:\Program Files\PennDOT\EngAsst 

v<version number>\" or "C:\Program Files (x86)\PennDOT\EngAsst v<version number>\" for 64-bit operating 

systems: 

 

 1. EngAsst.exe - Engineering Assistant executable program 

 2. EngAsstRevReq.dotx - Revision Request form (MS Word template) 

 3. EngAsst Users Guide.pdf - Program User’s Guide (PDF Format) 

 4. GenericRevReq.dotx - Generic Revision Request form for use with all engineering 

programs (MS Word Template) 

 5. LicenseAgreement.pdf - Licensing agreement for EngAsst (PDF Format) 

 6. EngAsst.ini, report.ini - Initialization files containing configuration information 
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In addition, a ProgIni folder is created under the destination folder. Upon installation, this folder is empty, but as 

engineering programs are added to the Engineering Assistant access list, it will contain configuration information 

for each engineering program. Users must have write access to this folder in order to register or unregister an 

engineering program. 

 

Also note that if the Microsoft .NET Framework version 4.6.1 is not installed on the target PC, it will be installed as 

part of the program installation. Version 4.6.1 of the Framework is required for EngAsst. 
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3 ADDING ENGINEERING 
PROGRAMS 

 
 
 
Before creating new engineering program input files or importing existing input files, EngAsst must have information 

about which engineering programs are available to it.  

 

The programs are registered manually through the "Register Engineering Program ..." option on the "File" menu of 

EngAsst (see Figure 3-1): 

 

  

Figure 3-1 Register Engineering Program 

 

Start EngAsst and choose "File > Register Engineering Program ...". With the next dialog box, browse to the location 

of the engineering program and choose the engineering program executable. The engineering program must be 

installed, either locally or on a mapped network drive, before it can be registered with EngAsst. Note that engineering 

programs that reside on a UNC path (in the format \\server\folder) are allowed in EngAsst. 
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4 CREATING A NEW INPUT FILE 
 
 
 
After adding all of the desired engineering programs, the user has the option to either create new input files for use 

with the engineering programs or import existing input files.  

 

EngAsst is designed to support a wide variety of input file formats, as each engineering program requires a different 

set of input record formats. The definition of record types, record relationships, field definitions, help text, images, 

etc., are all stored in EngAsst as a set of configuration files unique for each engineering program. When you create 

a new input file with EngAsst, you must first select which engineering program configuration you want to use. When 

you save an input file using EngAsst, it is stored as a text file with a special code attached to each record so that 

when it is opened with EngAsst, the data is shown under the appropriate tab in the Input Editor window. 

 

It is strongly recommended that the input file created with EngAsst not be modified by any other text editor or input 

processor. 

 

The descriptions in this guide use several terms when referring to input files and the data contained in them. Going 

from most specific to most general, they are field, record and record set. 
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4.1 FIELD  

Input fields are the most specific level of input. Each field contains a single piece of input information. Several fields 

are shown in Figure 4-1: 

 

 

Figure 4-1 Field Definition 

Input Fields 
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4.2 RECORD 

Records are collections of fields, all generally related to a single topic. A single record refers to a single input 

command for each program. Most individual tabs refer to a single type of record, except when the tabs refer to 

record sets, as described next. There can be multiple records of the same type associated with a single tab. For 

example, when defining cross sections of a steel beam, there will probably be multiple records to define different 

cross sections along the beam, as shown in Figure 4-2. 

 

  

Figure 4-2 Record 

 

A record which is NOT 
part of a record set. 
 
In this case there are 8 
APL records defined in 
this input file 
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4.3 RECORD SET 

When one or more records are closely related, they can be grouped into record sets so that they are all entered 

under a single tab. The most prevalent example of this is special live load commands, as shown in Figure 4-3. 

Generally for each special live load, the user must enter a single record describing the vehicle geometrically and 

another record to define each axle load and its location. 

 

  

Figure 4-3 Record Set 

 

Records which are associated with 
a record set. In this case, the 
LANE and TRUCK records are 
part of the LOADING record set. 

The SpecLL tab is 
actually a record set 
containing the SLL 
and SAL records 
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4.4 CREATING THE INPUT FILE 

To create a new input file, choose the "New" option from the "File" menu. The user is then presented with a list of 

the programs that were added to the program in the previous step (see Figure 4-4). 

 

 
 

Figure 4-4 Select Engineering Program Dialog 

 

After choosing the engineering program, EngAsst will present a series of blank tabs, ready for the user to fill with 

input. Any fields that are absolutely required for running the engineering program will already have blank forms 

prepared to fill in (as shown in Figure 4-5): 
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Figure 4-5 Blank Input Record 
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In cases where an input command is not absolutely required, the user will need to add the record (as shown in 

Figure 4-6) if they want to enter input for a command (and add more as required): 

 

 

Figure 4-6 Adding a New Record 
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Some commands are grouped together as a "Record Set". For these commands, the user must first add a "Record 

Set", then add records for each record inside the record set (see Figure 4-7): 

 

  
Figure 4-7 Adding a Record Set 

 

The user should review each tab, to see if they need to enter data for the command. If they do, they can add records 

and record sets as necessary. 

Add Record Set first 

The records which make 
up the record set 
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5 IMPORTING AN EXISTING 
INPUT FILE 

 
 
The other input option the user has is to import an input file created outside of EngAsst. This file may have been 

created from scratch by the user using a text editor or by using another input editor like PennDOT's Input Data 

Processor (IDP) program. The first time the user opens the file to be imported, an engineering program will have to 

be chosen to associate with the input file. After the file is imported and saved, the user will no longer have to choose 

the engineering program to associate with the input file. EngAsst can also work with files located on a UNC path 

(in the format \\server\folder). 

 

EngAsst can read input files in two different formats: fixed format (as used with BAR7, PS3 and other earlier 

PennDOT programs) or free format (as used with the LRFD programs and other recent engineering programs). If 

the input file was created with one of PennDOT's input processing programs (BAR7IP, ArchIP, etc.), EngAsst will 

attempt to read the codes produced by the input processing program to identify each line of input. If the input file is 

missing any of these codes or if the codes are incorrect, the user will have to associate each line of a fixed format 

input file with a command specific to the program (as shown in Figure 5-1). The input file shown in Figure 5-1 has 

some lines with input processing program codes and some lines without. The user only has to identify the lines that 

do not have an input processing program code. The user selects a line on the left side of the window, then double-

clicks on the record type (in the "Record Type" column). If the imported data file contains some blank records, 

assign these records with a "Comment" record type. After associating all of the lines in the input file with a record 

type, the user will click the "Done" button in the lower right corner of the window. EngAsst will then attempt to read 

the input file with the associated records. 
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Figure 5-1 Import Data File 

 

When reading in free format files, no user intervention is required since every line is identified by a unique command 

name. However, since some commands in free format files can be entered several different ways (for example, 

concentrated loads in STLRFD and PSLRFD can be entered as single loads on many separate concentrated load 

commands, as several loads on a single command or as several loads on each of several commands), these 

differing combinations can lead to EngAsst having problems reading the input file.  

 

In the example shown in Figure 5-2, EngAsst is unable to parse a UDF command in the input file and prints a 

warning message to that effect. 

 

 

Figure 5-2 Import File Error 

 

According to the STLRFD User's Manual, the user is allowed to enter up to 40 separate fatigue points, either by 

repeating them on one command or on multiple commands. EngAsst allows the user to enter up to four fatigue 
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points per record and up to ten fatigue records (see Figure 5-3). The existing input file in this case had five fatigue 

points on a single FTG command: 

 
FTG 2,18.700,73.25,C',,2,38.2,73.25,C',,2,57.7,1.5,C',,2,77.2,1.50,C',,2,96.7,1.5,C' 

 

For this command to be parsed correctly (and to avoid losing data), after the user clicks OK to dismiss the dialog 

shown in Figure 5-2, the input file should be closed without saving and opened in a text editor and the FTG line 

broken up to have a maximum of four fatigue points per FTG command: 

 
FTG 2,18.700,73.25,C',,2,38.2,73.25,C',,2,57.7,1.5,C',,2,77.2,1.50,C' 

FTG 2,96.7,1.5,C' 

 

The other option is to keep the input file open in EngAsst, but re-enter the excess data by hand on one or more 

FTG records. 

 

A note about importing comments: any comments that exist before the data lines in the imported data file will be 

imported into the "Comments" tab of the input editor. Comments that are interspersed with the data will be 

associated with the data record immediately following the comment. If more than one comment line is associated 

with a data record, only the first comment line will be associated with the data while the subsequent comments will 

be imported into the "Comments" tab of the input editor. 
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Figure 5-3 Fatigue Example 
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6 WINDOWS AND MENUS OF 
THE ENGINEERING ASSISTANT 

 
 
This section gives a more in-depth view of the windows and menus of the Engineering Assistant. 

6.1 THE MAIN WINDOW 

The main window (Figure 6.1-1) that appears after loading or importing a file is comprised of six components: 

 1. The record type tab strip 

 2. The window sizing slider 

 3. The record display area 

 4. The record set controls 

 5. The documentation display area 

 6. The status bar 

 7. The extended field help display area 

 

  

Figure 6.1-1 Typical EngAsst Screen 
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6.1.1 Record Type Tab Strip 

At the top of the display is the record type tab strip. This displays the various record types defined by the 

current engineering input file configuration, in the sequence defined in the User's Manual for the engineering 

program. If more record types are present than can fit on the current width of the window, left and right 

arrow buttons are present on the right side to allow scrolling through the tabs.  

 

The configuration files for an engineering program can define "Tab Rules" which enable or disable a Tab 

based upon the value of data fields. If a Tab has been disabled, its label will be enclosed in brackets; for 

example, if the Tab label is "SPL", and it has been disabled, the label will be changed to "[SPL]". To further 

assist in identifying disabled Tabs, when the mouse is paused momentarily over a disabled Tab, the tool 

tip "Disabled" will display. If the Tab rules have been defined incorrectly, or if the processing involved in 

evaluating the Tab Rules is too noticeable (especially on slower workstations), the Tab Rules can be turned 

off by "unchecking" the Apply Tab Rules menu option in the Edit menu. 

 

Note that if by changing input on a given tab, another tab is disabled, any data entered on that now disabled 

tab will not be saved by EngAsst to the engineering program input file. If the given input is changed back 

so that the tab is reenabled, the data will still be present unless the input file was closed and reopened in 

the interim. That is, if a given input file is closed when the Tab Rules are enabled, only the data on enabled 

tabs will be saved. Any data on tabs that have changed to disabled will be permanently lost when the input 

file is saved and closed. 

6.1.2 Window Sizing Slider 

Immediately below the record type tab strip is a slider that, as it is dragged left or right, resizes the record 

display area and the documentation display area. The slider defines a percentage of the window width for 

each display area. As the window is resized, the percentage is re-applied. Note that the slider can be moved 

completely to the left or right to eliminate one of the display areas. This can be helpful when displaying an 

image in the documentation display area so that the image is scaled as large as possible. 

6.1.3 Record Display Area 

On the left side of the window, the data for the current record is displayed, along with a spinner control and 

buttons to modify the display. Individual fields on the current record are displayed in a scrollable format. 

Immediately below the scrollable portion of the record display area is the comment box, which allows entry 

of one comment line to be associated with the current record. 

 

Navigation in the record display area can be accomplished via the keyboard. The tab key moves the focus 

to the next field in the list, automatically scrolling to the field if it is not currently visible. The back-tab (or 

"Shift-Tab") key moves the focus to the preceding field, again scrolling up if necessary. The home key 
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moves the focus and scrolls the display to the first field on the record; the end key moves the focus and 

scrolls to the last field on the record. 

 

The "Record Spinner" control indicates the current record being displayed, and allows the user to scroll 

through multiple records. The "Add" button adds a new record of the current type to the end of the set of 

records. The "Ins" button inserts a new record ahead of the current record. When only one record is allowed 

for the current tab, the Record Spinner is not visible.  

 

Record data can be copied to a buffer using the "Cpy" (Copy) button, and the data for the current record 

can be overlaid with the copied buffer using the "Pst" (Paste) button. Normally, the "Ins" or "Add" button 

should be used prior to the "Pst" button. The "Rpt" (Repeat) button provides a short-cut for the sequence: 

Copy, Insert, Paste; it results in duplicating the current record. 

 

The fields for each record are displayed in the sequence listed in the user manual for the current engineering 

program. The label for each field matches the label used in the manual (with perhaps some abbreviations 

where necessary). Each field is defined to be one of five supported types: 

6.1.3.1 Text Box 

A normal text entry box, which allows entry of any keyboard character. All lower case characters will be 

translated to upper case when the user presses the tab key or clicks a mouse to move the focus away from 

the field. Text entry boxes are defined to have a maximum number of characters allowed, depending upon 

the definition of the field in the engineering program user manual. Normal entry mode uses the "insert" 

mode - new characters are inserted immediately preceding the location of the cursor. The user can toggle 

"overtype" mode on by pressing the "Insert" key. "Overtype" mode is indicated by a block cursor highlighting 

one character. The keyed data replaces the existing data. 

6.1.3.2 Numeric Field 

Like a text box, this allows free-form entry of numeric data. Non-numeric keys are ignored. The definition 

of the field will control whether the decimal point and/or the negative sign are allowable keystrokes. This 

type of field is used for numeric values for the engineering programs requiring the Command Style Free 

Format input file. 

6.1.3.3 Edit Mask 

This is indicated by the field being pre-filled with the underscore ("_") prompt character. The mask definition 

defines allowable characters for each character. See the help text displayed in the status bar for a 

description of the required data format. This type of field is used primarily for fixed format numeric fields of 

the old style engineering programs. When the user presses the tab key or clicks a mouse to move focus 

from the field, the data will be right-justified and zero-filled. Note that sometimes it may become necessary 
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to enter non-numeric data into an edit mask field. The F12 key can be used to remove the mask from the 

field, so that the entry field behaves like a text box. When the mask is removed, the label for the field turns 

red. At this point, the user is responsible for ensuring that the entered data matches a format supported by 

the engineering program. Hitting F12 again will toggle the mask back on. 

6.1.3.4 Drop Down List 

The user must select one of the allowable values in the drop down list. Typing the first character(s) of an 

item in the list is equivalent to selecting the value from the list by a mouse click. 

6.1.3.5 Combo-Box  

This is a text box that also includes a drop down list of "default" values. One of the items in the drop down 

list can be selected, or a different value can be keyed by the user. 

6.1.4 Record Set Controls 

When the current engineering input file configuration defines a tab as requiring a "Record Set" hierarchy of 

related records, the record display area has tabs at the bottom, indicating the various record types 

associated with this record set definition. The user must select a tab to indicate which record type in the 

record set is currently being viewed in the record display area and modified with the record control buttons. 

 

There are controls (a spinner control, and command buttons) at the top right of the display for maintaining 

the record sets on the tab. The record set spinner is used to scroll through each record set in turn. The 

"Add" button adds a new record set at the end, following all existing record sets. The "Ins" (Insert) button 

inserts a new record set ahead of the current one in sequence. The "Del" (Delete) button removes the 

current record set, implying removing all the records in it. 

 

Note that adding or inserting a record set does not automatically add any records to the record set. These 

functions merely create a logical "placeholder" for the records that are subsequently added using the 

Record functions. 

 

Note, too, that when the current tab does not require record sets, these record set controls are not visible. 

6.1.5 Documentation Display Area 

Each record type can be accompanied by one or more elements of documentation. These elements can 

be either text, tables or images. These pieces of documentation are displayed on the right side of the 

window. If multiple text, table or image documents are defined by the current engineering program 

configuration, there are tabs below the documentation to allow selecting which document to display. Note 

that if necessary, the text and table documents are scrollable. Image documents are scaled and resized as 

the window is resized, or as the window sizing slider is adjusted to resize the documentation display area. 
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6.1.6 Status Bar 

At the bottom of the window is a status bar that displays short message text. When you use the tab key or 

the mouse to move from field to field in the record display Area, the status bar displays a brief description 

of that field. By convention, this short help will include the numeric format and what units the data should 

be entered in (if applicable). It is possible to define extended documentation text for a field in the 

configuration files. If the current field has extended documentation defined for it, it will show up in the 

"Extended Field Help" portion of the Documentation Display Area. 

6.1.7 Extended Field Help 

The Extended Field Help pane gives additional detailed information about the active field. Not all fields have 

additional field-specific documentation. The contents of this field will change as the user clicks between 

parameters.  

6.2 THE FILE MENU 

 
Figure 6.2-1 The File Menu 

 

The "File" (Figure 6.2-1) menu entries are pretty basic. “New”, “Open...”, “Close”, “Save” and “Save As...” all refer 

to operations on an input file.  

 

The "Open..." option is used in opening an input file that is already created with EngAsst for editing the input and/or 

running the engineering program as well as importing an input file created with another input processor or text editor 
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and making it an input file for editing with EngAsst. Before such a file can be edited with EngAsst, it must be 

associated with the applicable engineering program using the Select Engineering Program and Import File windows. 

EngAsst will automatically facilitate this if the file to be opened is not an EngAsst input file. If the "Open as read-

only" box is checked, the user will be able to open the input file and edit it, but will not be allowed to save the file 

with the same file name. A new name must be given to the input file. After the file is opened, read-only status is 

indicated by "(Read-Only)" appended to the file name in the title bar of the EngAsst program window. 

 

"Change Program Association..." allows the user to change the association between an open input file and its 

engineering program and version. This can be used when the user accidentally chooses the incorrect program 

when importing a file for the first time. If the incorrect program is chosen, click through all of the warning messages 

that will occur, then choose "Change Program Association..." and choose the correct program. Do not save the file 

at any point during this process, as it will try to save the input data in the format of the incorrect program and throw 

out any data it does not know how to read. 

 

“Register Engineering Program...” allows a user to register a new engineering program with the list of choices for 

EngAsst, while "Unregister Engineering Program..." allows the user to unregister an engineering program from the 

list of choices. The user must select the engineering program executable and then select the "Open" button. These 

options are not included on some installations of EngAsst because write access to the directory where EngAsst is 

required to register and unregister programs. Some system adminstrators restrict access to program installation 

areas for security reasons. Contact the system administrator if access to these commands are required. 

 

The next five lines are the last five files saved from EngAsst. Click on the name and path to reopen that file. 

 

"Exit" causes the EngAsst program to close. 
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6.3 THE EDIT MENU 

 

 
Figure 6.3-1 The Edit Menu 

 

The “Edit” menu deals with input data information. The entries on this menu refer to "Record Sets" or “Records”. 

Record Sets are groups of record types that work together, while Records are either commands that stand by 

themselves or combine to make up Record Sets. "Add Record Set" adds a record set at the end of the selected 

record set. "Insert Record Set" inserts a new record set before the selected record set. "Delete Record Set" 

completely deletes the current record set. 

 

Similar functions are done to individual records by "Add Record", "Insert Record" and "Delete Record". "Repeat 

Record" makes a copy of the current record and inserts it immediately after the current record (shifting any other 

records forward one slot). "Copy Record" copies the current record to the clipboard. If another record is made active, 

then "Paste Record" overwrites that active record with the information from the clipboard. 

 

“Maintain Image Aspect Ratio” causes any image in the "Help Pane" to maintain its aspect ratio (not get stretched) 

as the Help Pane is resized via the "Size Slider" (as shown in Figure 6.3-1).  
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“Apply Tab Rules” allows the user to specify whether or not the rules about which tabs are active or disabled are 

enforced or not. If "Apply Tab Rules" is disabled (unchecked) all tabs will be available regardless of user input. 

When enabled, any tabs which are not available are indicated by parentheses around the tab name. In Figure 6.3-

2, the "UDF" tab is disabled because the user has chosen to use computed distribution factors with the CDF and 

SKW commands. The "DRB", "DP1" and "DP2" commands have been disabled because this is an analysis run of 

a plate girder: 

 

  

Figure 6.3-2 Disabled Tabs 

 

"Open PDF Output (if available)" will cause EngAsst to open the PDF version of the engineering program output, if 

the engineering program has been enhanced to produce PDF output. After executing the engineering program, 

EngAsst will automatically open the primary output file, and another window that allows the user to open any other 

available PDF files associated with that program run. Turning this function off will force EngAsst to always open the 

"classic" output view described in Section 6.4. 

 

The options "Run EXE - Command Window" and "Run DLL - Command Window" should only be selected if directed 

by the Department for debugging purposes. These options change how the engineering programs are run and 

should only be used if the default method of running the programs does not work. 
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6.4 THE VIEW MENU 

 
Figure 6.4-1 The View Menu 

 

The “View” menu (Figure 6.4-1) allows the user to display different information about the current input file. Choosing 

"Program Input" will display the program input in a tabular format (Figure 6.4-2 and Figure 6.4-3), similar to the 

actual input file for the engineering program: 

 

 

Figure 6.4-2 Program Input View (Fixed Format Example) 

 
This window displays all of the records in the input file in sequence, as they are saved in the file. There are three 

columns in the display:  
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1. #  relative record number 

 

2. Type record type for fixed format input file or the keyword for the command style free format input 

file. This is the same as the label from the tab on the record type tab strip. 

 

3. Data data for fixed format input or parameter values for command type input. 

 

For a fixed format input file, the data is displayed without any delimiter between the fields; for command style free 

format input files, the data is comma-delimited. 

 

Note that comments which are associated with records are also displayed with a "Comment" record type ahead of 

the record with which they are associated. 

 

Clicking on any row in the program input view will scroll the input edit window to display the record associated with 

the current row. 

 

 

Figure 6.4-3 Program Input View (Command Type Free Format Example) 
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The "Program Output" selection will only be active when there actually is an output file to view. This option becomes 

active if there is an output file with a filename of the form: "<input filename>.out" and will open the output file (Figure 

6.4-4). This window allows the user to browse the program output file using the "Search" and "Table of Contents" 

tools. It also gives options to save the output file in another location or print the output file. 

 

 

Figure 6.4-4 Program Output Window 

 
If there is an output file with the filename of <input filename>-out.pdf, and the user has selected the "Open PDF 

Output (if available)" option on the "Edit" menu, selecting the "Program Output" option will open the <input 

filename>-out.pdf file in Adobe Acrobat, and open another window with a list of available PDF output files, allowing 

them to also be chosen to be opened with Acrobat: 
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Figure 6.4-5 Available PDF Output Window 

 

Double-clicking on any line in this window, or selecting a line then clicking "Select" will open the file in Adobe 

Acrobat. 
 
The "Analysis Graph" selection allows the user to view unfactored moment, shear, and deflection results 
for engineering programs that have been revised to provide these results in a format readable by EngAsst. 
The selection is only active for programs that have generated the EngAsst readable results (in files that 
end in *_DBR.CSV and *.DBT). The user can choose which load and which results are displayed (Figure 6.4-
6). 
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Figure 6.4-6 Analysis Graphs Window 
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6.5 THE RUN MENU 

The “Run!” menu does not have any sub-entries; by selecting this menu, the "Run Program" window will open, 

allowing the user to run the program (Figure 6.5-1). 

 

 
Figure 6.5-1 Run Dialog 

 
The top half of the dialog box shows the location and name of the executable that will be run. This is not changeable 

by the user. The check box next to "Automatically overwrite output files if present?" gives the user the option to 

automatically overwrite the output files associated with the current input file. If the user does not check this box but 

there are output files present, EngAsst will prompt the user if they wish to overwrite the files. For programs like 

PaPier where there may be multiple output files, the user would have to answer the dialog several times.  

 

The bottom half of the dialog box will only appear if the associated engineering program allows the functionality of 

a separate live load file containing a special live load vehicle. If the program does allow it, the bottom half of the 

window will appear, and will become active if the checkbox is selected. The user can then browse to a special live 

load file, or choose one from the pulldown menu. EngAsst will remember the last 10 special live load files selected. 

See Section 8 for more information on how to create these special live load files. 

 

Note that EngAsst can run engineering programs and input files located on a UNC path (in the format 

\\server\folder) or on a drive path (in the format drive:\folder). 

file://server/folder
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6.6 THE HELP MENU 

 
Figure 6.6-1 The Help Menu 

 
Finally, “Help” is another typical menu (Figure 6.6-1), giving access to documentation for input commands, the 

engineering program and EngAsst. 

 

"Show Engineering Program Documentation" will open the engineering program User's Manual in Adobe Acrobat 

format. Here the user can click on various bookmarks to go to a desired section of the user's manual. If a User's 

Manual in Adobe Acrobat format is available, but the Adobe Acrobat Reader is not installed on the User's machine, 

the user will be advised that the Adobe Acrobat Reader should be installed to view the User's Manual. 

 

"Revision Request Form" will open a blank revision request form in Microsoft Word. This file can be used to report 

a problem or enhancement request for any engineering program or EngAsst itself. The revision request form will 

not open if Microsoft Word is not installed on the PC. 

 

"Engineering Assistant User's Guide" opens this User's Guide in Adobe Acrobat format. This is the best source of 

information about EngAsst. 

 

After installation of EngAsst, to find the license number and version number of the program, choose the "About 

Engineering Assistant ..." option from the Help menu (Figure 6.6-2): 
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Figure 6.6-2 Help About EngAsst 

 

Clicking on "License Agreement" opens the EngAsst license agreement document. 
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7 ADDITIONAL WINDOWS 
 
 
 
When opening an input file for the first time, creating a new input file or changing the association of an input file to 

another engineering program, the user will be prompted for the engineering program corresponding to the input file 

via the window shown in Figure 7-1. 

 
 

 
Figure 7-1 Select Engineering Program Window 

 

This window, in a slightly different format, will also open when the "Unregister Engineering Program ..." option is 

selected.  

 

EngAsst can be associated with only one version of a program at a time. If an input file was imported or created 

with a program or program version that is no longer registered with EngAsst, the user will have the option to 

associate the input file with a new program and/or program version. 
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Finally, the most-often used commands can also be accessed through the toolbar buttons shown in Figure 7-2. 

 

 

Figure 7-2 Toolbar Buttons 

 
The first three buttons (from left to right) are the New, Open and Save buttons. These can all be accessed through 

the file menu and do the expected tasks on engineering program input files. The next four buttons are View 

Program Input, Run!, View Program Output, and View Analysis Graph. The View Program Input, View Program 
Output, and View Analysis Graph buttons correspond to the entries on the View menu, while Run! performs the 

same task as the Run! menu. The final two buttons are Engineering Program Help and EngAsst Help, both of which 

are also included on the "Help" menu. 
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8 THE LLOAD AND LLBOX 
OPTIONS 

 
When installing EngAsst, the option is given to install two extra programs called LLOAD and LLBOX. These are not 

engineering programs, but sets of configuration files that can be used to create special live load files for use with 

BOX5 (LLBOX), BAR7 and PS3 (LLOAD). The user has the option, when choosing the "Run!" option for BAR7, 

BOX5 or PS3 to specify a separate live load input file, as shown in Figure 8-1. 

 

 

Figure 8-1 Run Dialog Box 

 

To create these special live load input files, choose "New" from the "File" menu, then select either LLBOX or LLOAD 

from the "Select Engineering Program" window, then enter and save the data as usual. Then, when working with a 

BAR7, BOX5 or PS3 file, choose the "Run!" menu, click in the checkbox next to "Use Special Live Load Input File?", 

then browse to where the LLBOX or LLOAD input file was saved. 

 



Chapter 8  The LLOAD and LLBOX Options 
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9 REVISION REQUESTS 
 
 
 
This chapter contains a reply form to make it easier for users to convey their questions, problems or comments to 

the proper unit within the Department. General procedures for using this form are given. Users should keep the 

form in the manual as a master copy which can be reproduced as needed. It is also included as a Word template 

on the disk that has been provided for the program.  

 

This form is to be used to report suspected program malfunctions that may require revisions to the program. It can 

also be used to request revisions for the enhancement of the program. Unexpected or incorrect output, rejection of 

input data, endless program cycling, and program crashes are examples of program malfunctions. Users are 

requested to review their input data and the program User’s Guide before submitting this form for processing.  

 

This form may also be used to submit suggestions for improving the User’s Guide for this program. Suggestions 

might include typographical error correction, clarification of confusing sections, expansion of certain sections, 

changes in format, and the inclusion of additional information, diagrams, or examples.  

 

The completed form should be sent to the Highway Applications Division via fax or e-mail. 
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EngAsst 
REVISION REQUEST 

This form is to be used to report suspected program malfunctions, or to request revisions to the program or its 
documentation. Users are requested to review their input data and the program User’s Guide before submitting 
this form.  
CONTACT PERSON: _______________________________________ DATE: ____________________ 
ORGANIZATION: ______________________________________ PHONE: ____________________ 
E-MAIL ADDRESS: ______________________________________ FAX: ____________________ 

PROGRAM VERSION: _________ 
 

Define your problem and attach samples and/or documentation you feel would be helpful in correcting the 
problem. If the input data is more than 4 or 5 lines, Licensees should provide the input data file on a diskette. If 
you require more space, use additional 8½ x 11 sheets of plain paper. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
FORWARD COMPLETED FORM TO: Pennsylvania Office of Administration 

Infrastructure and Economic Development 
Bureau of Business Solutions and Services 
Highway Applications Division 
E-MAIL: PenndotBisEngineer@pa.gov 
PHONE: (717) 783-8822 
FAX: (717) 705-5529 

FOR DEPARTMENT USE ONLY 
RECEIVED BY: ________________  ASSIGNED TO: ___________________ DATE: _____________ 
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